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COPYRIGHT INFORMATION

No part of this manual, including the products and software described in it, may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated 
into any language in any form or by any means, except documentation kept by the purchaser for backup purposes, without the express written permission of 
Graphic Products, Inc.

Products and corporate names appearing in this manual may or may not be registered trademarks or copyrights of their respective companies, and are used only 
for identification or explanation and to the owners’ benefit, without intent to infringe.

Specifications and information contained in this manual are furnished for informational use only, and are subject to change at any time without notice, and should 
not be construed as a commitment by Graphic Products. Graphic Products assumes no responsibility or liability for any errors or inaccuracies that may appear in 
this manual.

Note: Illustrations in guide are for general reference 
only and do not show the final product.
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INTRODUCTION
LabelForge PRO gives you the power to quickly and easily create customized label designs for a variety of applications.

The software includes several ways to create new labels or signs. Some of the modules are for compliance-focused labeling, 
such as Chemical Labeling (using the GHS label structure) and Arc Flash Labeling (using the NFPA 70E label requirements). You 
can also create completely free-form labels with the Label Designer module.

On the DuraLabel Kodiak or Toro Max systems, these modules are accessible through the Label menu on the system’s main 
screen. On a PC, the modules are accessible from the program’s main screen.

This guide will get you started making labels with LabelForge PRO. For additional assistance, please contact your DuraLabel 
representative.

INSTALLING LABELFORGE PRO ON YOUR PC
NOTE: You may need IT administrator privileges to install the design software.

1. Insert the installation CD or connect the software flash drive to your computer. When the startup screen appears, choose 
Install LabelForge PRO. 

2. Accept the license agreement and click Next.

3. Choose an installation directory; by default, this will be “C:\Program Files (x86)\Label Forge Pro.” Then, click Next.

4. Review the installation details and click Finish to install LabelForge PRO. You will see a progress bar as the software is 
installed.

Once the software has been installed, you will be able to start designing your own labels on your PC.

LABEL DESIGNER
The Label Designer module is meant for creating or editing completely custom designs, using text, images, or barcodes. These 
items can be placed and modified with the menus, and can be moved around your label by dragging them on the design area.

1. Toolbar

2. Design Area

3. Insert menu

4. Dimensions menu

5. Order menu

6. Details menu

7. Color menu

8. Data Source menu

9. Label Settings menu

10. Print Settings menu
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Label Designer Toolbar
The toolbar across the top of the screen shows some common controls and options for the Label Designer. 

1. Hamburger Menu: Access common file options, such as creating a new design, saving and loading designs, and choosing 
program settings.

2. Quick Save: Save the current label design with its current file name. If you haven’t saved the file yet, you will be prompted to 
choose a file name and location.

3. Group/Ungroup: Set a group of selected objects to act as a single large object, or reverse this choice. Grouped objects will 
be moved and resized together.

4. Undo/Redo: Cancel a recent action, or repeat a canceled action.

5. Copy/Paste/Delete: Duplicate or remove the selected object.

6. Zoom Out/In/Fit: Adjust your view of the design to allow fine tuning.

7. Close: Close the Label Designer.

Creating a Label Design
When you open Label Designer, or choose the New Label option in the Hamburger Menu, the New Label window will open.

The New Label Options include the length and width of your design. On the Kodiak or Toro Max systems, you can also choose 
“Reset to Tape Size” to set your label dimensions to the default size for your loaded label stock. If your label stock uses pre-
printed elements, check the Show Supply Background checkbox to show those preprinted elements on the screen.

The New Label Template section of the window lets you choose a premade template to apply to your new design, such as an 
ANSI-style warning template or a basic barcode template. By default, you will start with a blank label (with no elements in place), 
but you can also choose a Template Category from the drop-down menu and choose a template from the previews that appear. 
These templates will be automatically adjusted to fit your label’s dimensions.

Once you have made your selections, click Finish to start designing your label.
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Insert Menu and Design Objects
Each object on your label, such as a text box or an image, is added to your label through the Insert Menu.

Click on the desired item type to add it to the center of your label; when an object has been added to the design, the new object 
will automatically be selected for editing.

• Text: Add simple text items to your label, useful for headers or static information. Basic text can be set to a fixed size or locked 
in place.

• Rich Text: Add rich text items, useful for descriptive or dynamic content. Rich text can wrap within a box, and different parts of 
the same item can use different font styles.

• Linear Barcode: Add a line-style barcode in a variety of formats. Supported formats are Codabar, Code 128, Code 128B, Code 
2 of 5 (Interleaved 2 of 5), Code 39, EAN13 (ISBN), EAN8 (8-2, 8-5), UPC-A (A2, A5), and UPC-E (A2, A5).

• 2D Barcode: Add a grid-style barcode in a variety of formats. Supported formats are Data Matrix, PDF417, and QR Code.

• Image: Import a custom image, such as a company logo. Selecting this option will prompt you for the file that you want to use; 
supported file types are .bmp, .gif, .jpg/.jpeg, .png, and .svg.

• Shape: Add geometric shapes such as lines, rectangles, and circles to your design. You can change the style of a selected 
Shape object by clicking on a different shape in the menu.

• Symbols: Add standardized symbols from a massive library, sorted by categories such as “Arrows,” “Injury,” and “Prohibited.” 
Choose a category on the left side of the Symbols window, select the desired symbol on the right side, and click the Insert 
button to add that symbol to your design.

Dimensions Menu
When an object is selected, use this menu to precisely control the object’s size, location, or rotation. You can also quickly adjust 
an object’s size by dragging the control boxes at its corners, or move the object by dragging it across the design area.

Order Menu
When an object is selected, use this menu to adjust the object’s arrangement relative to other objects or the label as a whole. 
You can center objects on the label, or align multiple selected objects to each other. You can also control whether an object 
covers up another, or is covered instead.

Details Menu
When an object is selected, use this menu to adjust the unique options available for that type of object. For example, for text 
objects, you can change the font and size, while for barcode objects, you can choose the barcode format.

Color Menu
When an object is selected, use this menu to choose the colors for that object. You can select a wide variety of colors, even if the 
appropriate supplies are not currently loaded, but only colors that match your loaded supplies can be printed accurately.
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Data Source Menu and Automatic Label Content
Connect your label design to a spreadsheet or database, and automatically generate a series of matching labels, or add 
automatically-generated content to your existing label design.

To use this function, start by selecting the type of Data Source that you want to use, from the drop-down menu:

• ArcFlash: Pull information from an arc flash database, like the one used by LabelForge PRO’s Arc Flash labeling module.

• CSV: Use a spreadsheet that has been saved in the widely-used Comma-Separated Value (CSV) format.

• DSN: Use a Data Source Name to get information from a database, following ODBC protocols. Network connections are 
possible; check with your IT team for help.

• Function: When using other Data Sources, the Function option lets you apply additional formatting to the information from 
those sources. It also provides a way to use more than one Data Source in a single design object, such as a product name 
immediately followed by its part number and description.

• GHS: Pull information from a GHS-style chemical database, like the one used by LabelForge PRO’s Chemical Labeling module.

• ImageFolder: Select a folder of images to print, with each image appearing on its own label.

• NFPA: Pull information from an NFPA-style chemical database, like the one used by LabelForge PRO’s NFPA/RTK labeling 
module.

• Sequence: Set up a sequence of numbers, automatically counting from a given start value to a given end value. You can also 
add a prefix, suffix, or zero padding. No separate file is needed.

• SQLite: Use the SQLite database management system to get information from a database. Network connections are possible; 
check with your IT team for help.

• TextList: Set up a sequence of text phrases, with each phrase appearing on its own label.

• Time: Add the current date or time (as set on your PC) to each label as it is printed.

• XLSX: Use a spreadsheet that has been saved in the Microsoft Excel workbook format (Excel 2007 or newer).

(For the ArcFlash, CSV, GHS, ImageFolder, NFPA, or XLSX Data Source types, the necessary file or files will need to be available 
on the system where you are using LabelForge PRO.)

After selecting the type of Data Source you want to use, click Add. Make the appropriate selections in this window to set up your 
Data Source.

Once a Data Source has been set up, select a Text, Rich Text, Linear Barcode, or 2D Barcode object on your design. (If you are 
using an ImageFolder, select an Image or Symbol object instead.) Then, select the desired field from the Data Source Field 
dropdown menu. The object will be automatically updated to reflect the contents of that field for the current record in the Data 
Source.

The Navigation section at the bottom of the Data Source menu shows the current record and the total number of records in the 
current Data Source. You can also cycle through the records or jump to a specific record.

Label Settings Menu
Choose basic label design options, such as the size of the label you are creating (or a dynamic size, which extends or shrinks to 
match your content) and the supplies you plan to use when printing your label.

Print Settings Menu
Adjust printing options, such as the common printing preferences. You can also choose which labels to print from an 
automatically-generated set of labels, if you are using a Data Source.

When you are ready to print your label, click the Print button in the Print Settings menu.
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ARC FLASH
The Arc Flash module uses a searchable, editable database to keep track of your equipment details, and simplify the task of 
creating arc flash warning labels that match the NFPA 70E and CSA Z462 standards.

1. Toolbar

2. Design Area

3. New Record

4. Edit Record

5. Save Database button

6. Save Label button

7. Delete Record button

8. Label Settings menu

9. Print Settings menu

Arc Flash Toolbar
The toolbar across the top of the screen shows some common controls and options for the Arc Flash labeling module.

1. Hamburger Menu: Access common file options, such as creating a new record, saving records, and exporting label designs.

2. Search Records: Search the arc flash database by equipment name, date, or project name.

3. Record Number: Identify the current record, out of the current database or search results.

4. Zoom Out/In/Fit: Adjust your view of the design to allow fine tuning.

5. Close: Close the Arc Flash labeling module.

Navigating Records in the Database
The fastest way to find a specific record in the Arc Flash database is with the toolbar’s search function.

1. Choose whether to search by Name (of the equipment), Date (of the arc flash risk assessment), or Project. The default 
search is by equipment name; to change this selection, click the current search type (such as “Name”) in the toolbar, and 
make a new selection.

2. Type your search terms in the search box, and click the magnifying glass button or press Enter on your keyboard.

3. The first match (in alphabetical order, by equipment name) will be shown in the design area. Use the right or left arrows in 
the toolbar to browse through the search results.

The number in the white box on the toolbar shows which search result you are currently seeing; the number below the box shows 
the total number of search results. If you do not enter any search terms, you can browse through the entire current database.
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Creating and Editing Arc Flash Records
To create a new entry in your current Arc Flash database, click the New Record button in the menu on the right. This creates a 
new, blank record. The Edit menu will slide out to let you add the details for this new material. This is where you will enter the 
details for the current label:

1. Label Options: Choose the Danger, Warning, or Caution header, and choose a project (or type a new project name) to keep 
related labels together.

2. Label Information: Enter the basic information for this label (equipment name, nominal voltage, arc flash boundary, and 
assessment date).

3. PPE Information: Choose whether the label will show an Arc Flash PPE Category or a calculated Incident Energy and 
Working Distance, and enter the appropriate information.

4. Also in the PPE section is the button for “List of PPE.” This will open a window where you can select the complete list of 
required PPE items by checking the box for each required item. By default, the list of PPE is alphabetical, but you can also 
sort the list by PPE categories: click the number for the category you want listed first. If desired, you can add, remove, or edit 
PPE items in this list as well.

5. Shock Hazards: Enter the voltage and conditions of a shock hazard, as well as the Limited Approach Boundary and 
Restricted Approach Boundary.

When the details have been entered, click the Save Database button to add your new entry to the Arc Flash module’s current 
database. The Save Label button will export your current label design to its own file, so you can adjust the design in the Label 
Designer module. If you want to remove the current record from the database, click the Delete Record button.

Templates, Sizes, and Settings

To print Arc Flash labels in different sizes, or to use custom templates, open the Label Settings menu and select the appropriate 
template with the drop-down Label Templates menu. The default templates are named so that the size of the label is shown first 
(with dimensions in inches).

In the same menu, you can also choose a font for the text of your label, and you can toggle optional label elements (such as grid 
lines or a border). You can also choose whether to print the colored stripe at the top of the label, or the header text and alert 
symbol; disable these options if you are using pre-printed label stock with those elements already in place.

This menu also lets you select which arc flash database you are using, if more than one database is available.

Printing a Label
When you are ready to print, click the Print Settings button. Here, choose which labels you want to print, and how many copies of 
each. You can also check a Print Preview here.

Click the Print button to start the new print job. 
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CHEMICAL LABELING
The Chemical Labeling module uses a searchable, editable database of chemical information to make GHS-style container 
labels. The module allows you to use the HazCom 2012 format (US/OSHA), or standardized GHS (UN/international).

1. Toolbar

2. Design Area

3. New Record

4. Edit Record

5. Save Database

6. Save Label

7. Delete Record

8. Label Settings

9. Print Settings

Chemical Labeling Toolbar
The toolbar across the top of the screen shows some common controls and options for the Chemical Labeling module.

1. Hamburger Menu: Access common file options, such as creating a new record, saving records, and exporting label designs.

2. Country/Authority Menu: Choose the format for your chemical labels: OSHA’s HazCom 2012 format, the UN’s international 
GHS format, or a custom style.

3. Search Records: Search Kodiak’s GHS-style chemical database by product name or identifying number.

4. Record Number: Identify the current record, out of the current database or search results.

5. Zoom Out/In/Fit: Adjust your view of the design to allow fine tuning.

6. Close: Close the Chemical Labeling module.

Navigating Records in the Database
The fastest way to find a specific record in the Chemical Labeling database is with the toolbar’s search function.

1. Choose whether to search by Product Name or one of the material’s identifying numbers (UN number, CAS Number, or EC 
Number). The default search is by chemical name; to change this selection, click the current search type (such as “Name”) 
in the toolbar, and make a new selection.

2. Type your search terms in the search box, and click the magnifying glass button or press Enter on your keyboard.

3. The first match (in alphabetical order, by equipment name) will be shown in the design area. Use the right or left arrows in 
the toolbar to browse through the search results.

The number in the white box on the toolbar shows which search result you are currently seeing; the number below the box shows 
the total number of search results. If you do not enter any search terms, you can browse through the entire current database.
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Creating and Editing Chemical Records
To create a new entry in your current chemical database, click the New Record button in the menu on the right. This creates a 
new, blank record. The Edit menu will slide out to let you add the details for this new material. (To edit an existing chemical entry, 
simply find that entry in the database and click the Edit Record button in the menu.)

1. Edit Label: Set the basic details for this entry, such as the product name, identifying numbers, signal word, and any 
supplemental information.

2. Hazard Symbols: Click on a symbol to make it appear on this label. Current symbols will be highlighted in orange; click on 
the symbol again to remove it.

3. Click the Hazard Statements button to open a new window and select the hazard statements for your material.

a. In this window, select an appropriate statement from the full list on the left (sorted by reference code). To find a specific 
statement, type in the search box in the lower left. When the desired statement has been selected, click Add Statement 
to add it to the current list, on the right.

b. For hazard statements with additional details, select the statement and type the appropriate information in the 
parameter fields in the lower right. For compliance with standards, hazard statements cannot be freely edited.

c. If you need to remove a statement from the current list, select it and click Remove Statement.

d. When you’ve added the appropriate Hazard Statements, click OK to continue.

4. Click the Precautionary Statements button to open a new window for these statements. As with Hazard Statements, select 
a statement from the left and click Add Statement.

a. As with Hazard Statements, select an appropriate statement from the full list on the left (sorted by reference code). To 
find a specific statement, type in the search box in the lower left. When the desired statement has been selected, click 
Add Statement to add it to the current list, on the right.

b. Precautionary statements can be edited by selecting a statement and typing. You can also add a blank statement with 
the Create Statement button to add your own customized text. Individual statements are separated by periods.

c. If you need to remove a statement from the current list, select it and click Remove Statement.

d. When you’ve added the appropriate Precautionary Statements, click OK to continue.

5. Supplier: If you have already entered information for the supplier or other responsible party, you can select that organization 
from the drop-down list. To add a new supplier or edit supplier information, click the Pencil button; this will open a new 
window for supplier details.

When the details have been entered, click the Save Database button to add your new entry to the Chemical Labeling module’s 
current database. The Save Label button will export your current label design to its own file, so you can adjust the design in the 
Label Designer module. If you want to remove the current record from the database, click the Delete Record button.

Templates, Sizes, and Settings
To print chemical labels in different sizes, open the Label Settings menu and select the appropriate template with the drop-down 
Label Size menu. In the same menu, you can also choose a font for the text of your label.

This menu also lets you select which chemical database you are using, if more than one database is available.

Printing a Label
When you are ready to print, click the Print Settings button. Here, choose which labels you want to print, and how many copies of 
each. You can also check a Print Preview here.

Click the Print button to start the new print job.
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NFPA/RTK
The NFPA/RTK module uses a searchable, editable database of chemical information to make supplemental chemical labels 
based on the NFPA 704 hazard rating system. This system assigns a numeric rating for a material’s hazards in each of three 
categories (health, flammability, and instability).

The NFPA 704 labeling system and its variations were originally intended to protect first responders in an emergency. 
These labels may not satisfy the regulatory requirements that apply in your case; check with your local authorities to ensure 
compliance.

1. Toolbar

2. Design Area

3. New Record

4. Edit Record

5. Save Database

6. Save Label

7. Delete Record

8. Label Settings

9. Print Settings

NFPA/RTK Toolbar
The toolbar across the top of the screen shows some common controls and options for the NFPA/RTK module.

1. Hamburger Menu: Access common file options, such as creating a new record, saving records, and exporting label designs.

2. Authority Menu: Choose the format for your chemical labels, using the familiar NFPA Diamond layout or an alternative RTK 
Color Bar format.

3. Search Records: Search Kodiak’s NFPA-style chemical database by product name or CAS number.

4. Record Number: Identify the current record, out of the current database or search results.

5. Zoom Out/In/Fit: Adjust your view of the design to allow fine tuning.

6. Close: Close the NFPA/RTK module.

Navigating Records
The fastest way to find a specific record in the NFPA/RTK database is with the toolbar’s search function.

1. Choose whether to search by the material’s Name or CAS Number. The default search is by chemical name; to change this 
selection, click the current search type (such as “Name”) in the toolbar, and make a new selection.

2. Type your search terms in the search box, and click the magnifying glass button or press Enter on your keyboard.

3. The first match (in alphabetical order, by equipment name) will be shown in the design area. Use the right or left arrows in 
the toolbar to browse through the search results.

The number in the white box on the toolbar shows which search result you are currently seeing; the number below the box shows 
the total number of search results. If you do not enter any search terms, you can browse through the entire current database.
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Creating and Editing Records
To create a new entry in your current NFPA-style chemical database, click the New Record button in the menu on the right. This 
creates a new, blank record. The Edit menu will slide out to let you add the details for this new material. (To edit an existing 
chemical entry, simply find that entry in the database and click the Edit button in the menu.)

1. NFPA Information: Set the basic details for this entry, such as the product name, CAS number, and signal word.

2. Edit Rating: Click the plus or minus buttons to adjust the ratings for the chemical, from 0 to 4.

3. Specific Ratings: If your material poses a special hazard, such as being an oxidizer (OX) or simple asphyxiant (SA), click the 
arrow to expand this section. Check the box for any hazard that applies.

4. Health Hazards: If your material poses a specific health hazard, such as being an irritant or carcinogen, click the arrow to 
expand this section. Check the box for any hazard that applies.

5. Organ Hazards: If your material poses a direct hazard to specific organs, such as kidneys or respiratory system, click the 
arrow to expand this section. Check the box for any hazard that applies.

6. PPE Symbols: If specific personal protective equipment (PPE) is required to safely handle this material, such as gloves or a 
respirator, click the arrow to expand this section. Check the box for any PPE symbol that you want to include. You can also 
add symbols to this list with the “Import” function.

7. Comments: If there are additional comments you would like to include on the label, click the arrow to expand this section 
and type your comments in the field provided.

When the details have been entered, click the Save Database button to add your new entry to the Chemical Labeling module’s 
current database. The Save Label button will export your current label design to its own file, so you can adjust the design in the 
Label Designer module. If you want to remove the current record from the database, click the Delete Record button.

Templates, Sizes, and Settings
To print NFPA-style chemical labels in different sizes, open the Label Settings menu and select the appropriate template with the 
drop-down Label Templates menu. The default templates are named so that the size of the label is shown first (with dimensions 
in inches).

In the same menu, you can also choose a font for the text of your label, and toggle optional elements such as PPE symbols and 
comments. Not all templates allow for PPE symbols and/or comment text.

This menu also lets you select which NFPA-style chemical database you are using, if more than one database is available.

Printing a Label
When you are ready to print, click the Print Settings button. Here, choose which labels you want to print, and how many copies of 
each. You can also check a Print Preview here.

Click the Print button to start the new print job. 
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PIPE MARKING
The Pipe Marking module uses the recommendations of the ANSI/ASME A13.1 standard to create simple and effective pipe 
labels. It also includes a specialized module for labeling the parts of ammonia-based refrigeration systems, following the 
IIAR Bulletin No. 114 approach. Finally, it includes a simple option for creating arrow wraps, which can be applied around the 
circumference of a pipe to show the direction of flow.

1. Toolbar

2. Label Preview

3. New Label button

4. Open Label

5. Save

6. Save As

7. Export Label

8. Print Settings

Pipe Marking Toolbar
The toolbar across the top of the screen shows some of the options for the Pipe Marking module.

1. Hamburger Menu: Access common file options, such as creating a new label, saving labels, and exporting label designs. 
The most common choices here are also available in the menu on the right side of the screen.

2. Module Menu: Choose the type of pipe marker you are creating: basic ANSI/ASME labels, ammonia refrigeration pipe 
labels, or arrow wraps.

3. Close: Close the Pipe Marking module.

Creating a Basic Pipe Marker
To create a new pipe label in the default ANSI/ASME A13.1 style, follow these steps:

First, decide on the printed content of your pipe marker, using the Pipe Legend box on the left side of the screen:

1. Click in the Text field and type the text that your label should include.

2. To add an arrow to either end of your label, click one of the dashed-line squares in the Pipe Legend box, and choose an 
arrow style from the slide-out menu that appears. Repeat the process for the other end of the label; if the same arrow 
should appear on both ends of the label, check the box for Apply to Both. To close the slideout menu, click the dashed-line 
square again.

3. If you prefer, you can adjust the text size or font with the options at the bottom of this window. The default selections are 
designed to be clearly readable.
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Then, set the dimensions of your pipe marking with the Label Size box on the right side of the screen:

1. Choose your Auto Resize preference:
a. Fit label to text: automatically set your label’s length to fit the text that you have entered
b. Fit text to label: automatically resize your text to fit the specified label dimensions
c. None: no automatic adjustments

2. Select the pipe diameter to use the recommended dimensions for a pipe of that size, or choose Custom Size to choose your 
own label size.

Finally, set special formatting options in the Formatting box on the right side of the screen:

1. Choose your label’s background color in the dropdown menu. (The print color, either black or white, will be chosen 
automatically for standard compliance and readability.)

2. Choose Landscape (default) or Portrait orientation for your label.

3. If you need your label to be visible from multiple directions, select Pipe Wrap. By default, this makes a label that will be 
readable from below the pipe; for a label that will be read from above the pipe, select Top.

Creating an Ammonia Pipe Marker
To create a new pipe or component label for ammonia-based refrigeration systems, using the IIAR Bulletin No. 114 styles, follow 

these steps:

1. Choose Ammonia Pipe Marking from the module menu in the toolbar.

2. Using the tabs at the top of the Pipe Legend box, on the left side of the screen, select whether you are making a pipe 
marker or a component marker. Then, set the printed content for the label:

a. To add an arrow to either end of an ammonia pipe marker, click one of the dashed-line squares in the Pipe Legend box, 
and choose an arrow style from the slide-out menu that appears. Repeat the process for the other end of the label; if the 
same arrow should appear on both ends of the label, check the box for Apply to Both. To close the slide-out menu, click 
the dashed-line square again.

b. To set the physical state or pressure levels for your marker, click the dashed-line boxes for those elements and make 
your selection from the slide-out menu that appears. Each slide-out menu also has a tab for printing these smaller labels 
separately. To close the slide-out menu, click the dashed-line square again.

c. Choose the equipment or system abbreviation, or the component name, from the list at the bottom of the Pipe Legend 
box. You can add custom items to the list with the Add button, or edit or remove selected items from the list with the Edit 
or Remove buttons.

3. In the Label Size box on the right side of the screen, select the pipe diameter to use the recommended dimensions for a 
pipe of that size, or choose Custom Size to choose your own label size.

4. The detailed size options in the Settings box will update automatically if you choose a pipe diameter; if you choose a custom 
size, you may need to adjust these options.

You can also choose whether to print with an orange background or with a yellow background (to match existing labels in the 
older format).
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Creating an Arrow Wrap

To create a band of printed arrows that can be applied around a pipe to show the direction of flow, follow these steps:

1. Choose Arrow Wrap from the module menu in the toolbar.

2. Choose the color of the band background. The arrow color, either black or white, will be automatically selected for standard 
compliance and visibility.

3. Select the diameter of the pipe you will be labeling; the program will automatically calculate recommended sizes and 
spacing. You can also manually set the wrap width, wrap length, arrow length, number of arrows, or spacing between arrows.

4. Set the arrow style by clicking on your choice in the Arrow Options box.

Saving or Exporting Label Designs
To save a label, click the Save button in the menu along the right side of the screen (or choose Save Label from the Hamburger 
Menu). If the label has already been saved, the existing file will be updated; if not, you will be prompted to choose a file name 
and location.

To save the label as a new file, leaving the old version intact, click the Save As button in the menu along the right side of the 
screen (or choose Save Label As from the Hamburger Menu). You will be prompted to choose a file name and location.

To export a label for fine-tuning or other adjustments in the Label Designer module, click the Export button in the menu along 
the right side of the screen (or choose Export Label from the Hamburger Menu). You will be prompted to choose a file name and 
location, and you will be able to open the new file in the Label Designer.

Printing a Label
When you are ready to print, click the Print Settings button. Here, choose which labels you want to print, and how many copies of 
each. You can also check a Print Preview here.

Click the Print button to start the new print job. 
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ADDITIONAL OPTIONS IN LABELFORGE PRO ON PC
When you start the PC version of LabelForge PRO, you will see the software’s Home Screen. You can also return to the Home 
Screen by clicking the Home button in the top left corner of the program window.

1. Toolbar

2. Home Button

3. Recent Labels Menu

4. New Tab Button

5. Live Chat Button

6. Resources Button

7. Labeling Modules

8. Support Buttons

Toolbar and Additional Options
When you open a labeling module, a tab for that module will appear in the toolbar. Multiple modules can be open at the same 
time; you can switch between them by clicking the different tabs.

You can quickly return to a recent label design with the Recent menu, near the top left corner of the screen.

The PC version of LabelForge PRO includes these additional modules:

• My Labels: Browse the label designs that you have created in the Label Designer module, using thumbnail previews of the 
labels.

• Resources: Quickly visit the Graphic Products website to view How-To Videos or read a digital copy of this User Guide. You can 
also reach this section by clicking the Resources (lightbulb) button in the top right corner of the program window. An internet 
connection is required.

Along the bottom of the program window are support buttons, allowing you to quickly Request Support, start a Live Chat with an 
available representative, or offer your Feedback on the software to help guide future updates. You can also start a Live Chat by 
clicking the chat icon in the top right corner of the program window. An internet connection is required for these options.

Printing From PC
When printing from the PC version of LabelForge PRO, you will see a standard Print dialog window where you can select which 
printer to use, and how many copies of the design to print. You can control your DuraLabel printer’s settings for this print job by 
selecting that printer and clicking the Preferences button in this window.


